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AVAYA SOFTWARE DEVELOPMENT KIT LICENSE AGREEMENT  

 

 

REVISED: January 14, 2022 

READ THIS CAREFULLY BEFORE ELECTRONICALLY ACCESSING OR USING THIS PROPRIETARY 

PRODUCT! 

THIS IS A LEGAL AGREEMENT (“AGREEMENT”) BETWEEN YOU, INDIVIDUALLY, AND/OR THE LEGAL 

ENTITY FOR WHOM YOU ARE OPENING, INSTALLING, DOWNLOADING, COPYING OR OTHERWISE USING 

THE AVAYA SOFTWARE DEVELOPMENT KIT (“SDK”) (COLLECTIVELY, AS REFERENCED HEREIN, “YOU”, 

“YOUR”, OR “LICENSEE”) AND AVAYA INC. OR ANY AVAYA AFFILIATE (COLLECTIVELY, “AVAYA”). IF 

YOU ARE ACCEPTING THE TERMS AND CONDITIONS OF THIS AGREEMENT ON BEHALF OF A LEGAL 

ENTITY, YOU REPRESENT AND WARRANT THAT YOU HAVE FULL LEGAL AUTHORITY TO ACCEPT ON 

BEHALF OF AND BIND SUCH LEGAL ENTITY TO THIS AGREEMENT.  BY OPENING THE MEDIA 

CONTAINER, BY INSTALLING, DOWNLOADING, COPYING OR OTHERWISE USING THE AVAYA 

SOFTWARE DEVELOPMENT KIT (“SDK”) OR AUTHORIZING OTHERS TO DO SO, YOU SIGNIFY THAT YOU 

ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.  IF YOU DO NOT HAVE SUCH 

AUTHORITY OR DO NOT WISH TO BE BOUND BY THE TERMS OF THIS AGREEMENT, SELECT THE 

"DECLINE" BUTTON AT THE END OF THE TERMS OF THIS AGREEMENT OR THE EQUIVALENT OPTION 

AND YOU SHALL HAVE NO RIGHT TO USE THE SDK. 

1.0 DEFINITIONS.  

1.1 “Affiliates” means any entity that is directly or indirectly controlling, controlled by, or under common control with 

Avaya Inc.  For purposes of this definition, “control” means the power to direct the management and policies of such party, 

directly or indirectly, whether through ownership of voting securities, by contract or otherwise; and the terms “controlling” 

and “controlled” have meanings correlative to the foregoing. 

1.2 “Avaya Software Development Kit” or “SDK” means Avaya technology, which may include Software, Client 

Libraries, Specification Documents, Software libraries, application programming interfaces (“API”), Software tools, 

Sample Application Code and Documentation.  

1.3 “Client Libraries” mean any enabler code specifically designated as such and included in a SDK. Client Libraries may 

also be referred to as “DLLs”, and represent elements of the SDK required at runtime to communicate with Avaya products 

or other SDK elements.  

1.4 “Change In Control” shall be deemed to have occurred if any person, entity or group comes to own or control, directly 

or indirectly, beneficially or of record, voting securities (or any other form of controlling interest) which represent more 

than fifty percent (50%) of the total voting power of the Licensee. 

1.5 “Derivative Work(s)” means any translation (including translation into other computer languages), port, compiling of 

Source Code into object code, combination with a pre-existing work, modification, correction, addition, extension, 

upgrade, improvement, compilation, abridgment or other form in which an existing work may be recast, transformed or 

adapted or which would otherwise constitute a derivative work under the United States Copyright Act.  Permitted 

Modifications will be considered Derivative Works. 

1.6 “Documentation” includes programmer guides, CDs, manuals, materials, and information appropriate or necessary for 

use in connection with the SDK. Documentation may be provided in machine-readable, electronic or hard copy form.  

1.7 “Intellectual Property” means any and all: (i) rights associated with works of authorship throughout the world, including 

copyrights, neighboring rights, moral rights, and mask works, (ii) trademark and trade name rights and similar rights, (iii) 

trade secret rights, (iv) patents, algorithms, designs and other industrial property rights, (v) all other intellectual and 



January 2024  Getting Started with the Avaya Breeze® platform SDK 3 

industrial property rights (of every kind and nature throughout the world and however designated) whether arising by 

operation of law, contract, license, or otherwise, and (vi) all registrations, initial applications, renewals, extensions, 

continuations, divisions or reissues thereof now or hereafter in force (including any rights in any of the foregoing).   

1.8 “Permitted Modification(s)” means Licensee’s modifications of the Sample Application Code as needed to create 

applications, interfaces, workflows or processes for use with Avaya products. 

1.9 “Specification Document” means any notes or similar instructions in hard copy or machine readable form, including 

any technical, interface and/or interoperability specifications that define the requirements and conditions for connection to 

and/or interoperability with Avaya products, systems and solutions. 

1.10 “Source Code” means human readable or high-level statement version of software written in the source language used 

by programmers and includes one or more programs.  Source Code programs may include one or more files, such as user 

interface markup language (.mxml), action script (.as), precompiled Flash code (.swc), java script (.js), hypertext markup 

language (.html), active server pages (.asp), C# or C# .Net source code (.cs), java source code (.java), java server pages 

(.jsp), java archives (.jar), graphic interchange format (.gif), cascading style sheet (.css), audio files (.wav) and extensible 

markup language (.xml) files.   

1.11 “Sample Application Code” means Software provided for the purposes of demonstrating functionality of an Avaya 

product through the Avaya Software Development Kit.  

1.12 “Software” means data or information constituting one or more computer or apparatus programs, including Source 

Code or in machine-readable, compiled object code form. 

2.0 LICENSE GRANT.  

2.1 SDK License. 

A. Provided Licensee pays to Avaya the applicable license fee (if any), Avaya hereby grants Licensee a limited, non-

exclusive, non-transferable license (without the right to sublicense, except as set forth in 2.1B(iii)) under the 

Intellectual Property of Avaya and, if applicable, its licensors and suppliers to (i) use the SDK solely for the purpose 

of Licensee's internal development efforts to develop applications, interfaces, value-added services and/or solutions, 

workflows or processes to work in conjunction with Avaya products; (ii) to package Client Libraries for 

redistribution with Licensee’s complementary applications that have been developed using this SDK, subject to the 

terms and conditions set forth herein; (iii) use Specification Documents solely to enable Licensee’s products, services 

and application solutions to exchange messages and signals with Avaya products, systems and solutions to which 

the Specification Document(s) apply; (iv) modify and create Derivative Works of the Sample Application Code, 

Specification Documents and Documentation solely for internal development of applications, interfaces, workflows 

or processes for use with Avaya products, integration of such applications, interfaces, workflows and processes with 

Avaya products and interoperability testing of the foregoing with Avaya products; and (v) compile or otherwise 

prepare for distribution the Sample Application Code with Permitted Modifications, into an object code or other 

machine-readable program format for distribution and distribute the same subject to the conditions set forth in 

Section 2.1B.   

B. The foregoing license to use Sample Application Code is contingent upon the following: (i) Licensee must ensure 

that the modifications made to the Sample Application Code as permitted in clause (iv) of Section 2.1A are 

compatible and/or interoperable with Avaya products and/or integrated therewith, (ii) Licensee may distribute 

Licensee’s application that has been created using this SDK, provided that such distribution is subject to an end user 

pursuant to Licensee’s current end user license agreement (“Licensee EULA”) that is consistent with the terms of 

this Agreement  and, if applicable, any other agreement with Avaya (e.g., the Avaya DevConnect Program 

Agreement), and is equally as protective as Licensee’s standard software license terms, but in no event shall the 

standard of care be less than a reasonable degree of care, and (iii) Licensee ensures that each end user who receives 

Client Libraries or Sample Application Code with Permitted Modifications has all necessary licenses for all 

underlying Avaya products associated with such Client Libraries or Sample Application Code.   

Your Licensee EULA must include terms concerning restrictions on use, protection of proprietary rights, 

disclaimer of warranties, and limitations of liability. You must ensure that Your End Users using applications, 

interfaces, value-added services and/or solutions, workflows or processes that incorporate the API, Client 
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Libraries, Sample Code or Permitted Modifications adhere to these terms, and You agree to notify Avaya 

promptly if You become aware of any breach of the terms of Licensee EULA that may impact Avaya. You will 

take all reasonable precautions to prevent unauthorized access to or use of the SDK and notify Avaya promptly of 

any such unauthorized access or use. 
C. Licensee acknowledges and agrees that it is licensed to use the SDK only in connection with Avaya products (and 

if applicable, in connection with services provided by or on behalf of Avaya).  

D. With respect to Software that contains elements provided by third party suppliers, Licensee may install and use 

the Software in accordance with the terms and conditions of the applicable license agreements, such as “shrinkwrap” 

or “click-through” licenses, accompanying or applicable to the Software. 

2.2 No Standalone Product.  Nothing in this Agreement authorizes or grants Licensee any rights to distribute or otherwise 

make available to a third party the SDK, in whole or in part, or any Derivative Work in source or object code format on a 

standalone basis other than the modifications permitted in Section 2.1B of this Agreement. 

2.3 Proprietary Notices.  Licensee shall not remove any copyright, trade mark or other proprietary notices incorporated in 

the copies of the SDK, Sample Application Code and redistributable files in Licensee’s possession or control or any 

modifications thereto. Redistributions in binary form or other suitable program format for distribution, to the extent 

expressly permitted, must also reproduce Avaya’s copyright, trademarks or other proprietary notices as incorporated in the 

SDK in any associated Documentation or “splash screens” that display Licensee copyright notices.   

2.4 Third-Party Components.  You acknowledge certain software programs or portions thereof included in the SDK may 

contain software distributed under third party agreements (“Third Party Components”), which may contain terms that 

expand or limit rights to use certain portions of the SDK (“Third Party Terms”). Information identifying the copyright 

holders of the Third Party Components and the Third Party Terms that apply is available in the attached Schedule 1 (if 

any), SDK, Documentation, or on Avaya’s web site at: http://support.avaya.com/Copyright (or such successor site as 

designated by Avaya).  The open source software license terms provided as Third Party Terms are consistent with the 

license rights granted in this Agreement, and may contain additional rights benefiting You, such as modification and 

distribution of the open source software.  The Third Party Terms shall take precedence over this Agreement, solely with 

respect to the applicable Third Party Components, to the extent that this Agreement imposes greater restrictions on You 

than the applicable Third Party Terms.  Licensee is solely responsible for procuring any necessary licenses for Third Party 

Components, including payment of licensing royalties or other amounts to third parties, for the use thereof. 

2.5 Copies of SDK.  Licensee may copy the SDK only as necessary to exercise its rights hereunder.  

2.6a No Reverse Engineering.  Licensee shall have no rights to any Source Code for any of the software in the SDK, except 

for the explicit rights to use the Source Code as provided to Licensee hereunder. Licensee agrees that it shall not cause or 

permit the disassembly, decompilation or reverse engineering of the Software. Notwithstanding the foregoing, if the SDK 

is rightfully located in a member state of the European Union and Licensee needs information about the Software in the 

SDK in order to achieve interoperability of an independently created software program with the Software in the SDK, 

Licensee will first request such information from Avaya. Avaya may charge Licensee a reasonable fee for the provision of 

such information. If Avaya refuses to make such information available, then Licensee may take steps, such as reverse 

assembly or reverse compilation, to the extent necessary solely in order to achieve interoperability of the Software in the 

SDK with an independently created software program. To the extent that the Licensee is expressly permitted by applicable 

mandatory law to undertake any of the activities listed in this section, Licensee will not exercise those rights until Licensee 

has given Avaya twenty (20) days written notice of its intent to exercise any such rights. 

2.6.b License Restrictions. To the extent permissible under applicable law, Licensee agrees not to: (i)  publish, sell, 

sublicense, lease, rent, loan, assign, convey or otherwise transfer the SDK; (ii) distribute, disclose or allow use the SDK, 

in any format, through any timesharing service, service bureau, network or by any other means; (iii) distribute or otherwise 

use the Software in the SDK in any manner that causes any portion of the Software that is not already subject to an OSS 

License to become subject to the terms of any OSS License; (iv) link the Source Code for any of the software in the SDK 

with any software licensed under the Affero General Public License (Affero GPL) v.3 or similar licenses; (v) access 

information that is solely available to root administrators of the Avaya products, systems, and solutions; (vi) develop 

applications, interfaces, value-added services and/or solutions, workflows or processes  that causes adverse effects to 

http://support.avaya.com/Copyright
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Avaya and third-party products, services, solutions, such as, but not limited to, poor performance, software crashes and 

cessation of their proper functions; and (vii) develop  applications, interfaces, value-added services and/or solutions, 

workflows or processes that blocks or delays emergency calls; (viii) emulate an Avaya SIP endpoint by form or user 

interface design confusingly similar as an Avaya product ; (ix) reverse engineer Avaya SIP protocol messages; or (x) 

permit or encourage any third party to do any of (i) through (x), inclusive, above.     

2.7 Responsibility for Development Tools.  Licensee acknowledges that effective utilization of the SDK may require the 

use of a development tool, compiler and other software and technology of third parties, which may be incorporated in the 

SDK pursuant to Section 2.4. Licensee is solely responsible for procuring such third party software and technology and 

the necessary licenses, including payment of licensing royalties or other amounts to third parties, for the use thereof.  

2.8 U.S. Government End Users.  The SDK shall be classified as "commercial computer software" and the Documentation 

is classified as "commercial computer software documentation" or "commercial items," pursuant to FAR 12.212 or DFAR 

227.7202, as applicable. Any use, modification, reproduction, release, performance, display or disclosure of the SDK or 

Documentation by the Government of the United States shall be governed solely by the terms of the Agreement and shall 

be prohibited except to the extent expressly permitted by the terms of the Agreement. 

2.9 Limitation of Rights.  No right is granted to Licensee to sublicense its rights hereunder. All rights not expressly granted 

are reserved by Avaya or its licensors or suppliers and, except as expressly set forth herein, no license is granted by Avaya 

or its licensors or suppliers under this Agreement directly, by implication, estoppel or otherwise, under any Intellectual 

Property right of Avaya or its licensors or suppliers. Nothing herein shall be deemed to authorize Licensee to use Avaya's 

trademarks or trade names in Licensee's advertising, marketing, promotional, sales or related materials. 

2.10 Independent Development.   

2.10.1 Licensee understands and agrees that Avaya, Affiliates, or Avaya’s licensees or suppliers may acquire, license, 

develop for itself or have others develop for it, and market and/or distribute applications, interfaces, value-added services 

and/or solutions, workflows or processes similar to that which Licensee may develop.   Nothing in this Agreement shall 

restrict or limit the rights of Avaya, Affiliates, or Avaya’s licensees or suppliers to commence or continue with the 

development or distribution of such applications, interfaces, value-added services and/or solutions, workflows or 

processes. 

2.10.2 Nonassertion by Licensee.  Licensee agrees not to assert any Intellectual Property related to the SDK or applications, 

interfaces, value-added services and/or solutions, workflows or processes developed using the SDK against Avaya, 

Affiliates, Avaya’s licensors or suppliers, distributors, customers, or other licensees of the SDK.  

2.11 Feedback and Support.  Licensee agrees to provide any information, comments, problem reports, enhancement 

requests and suggestions regarding the performance of the SDK (collectively, “Feedback”) via any public or private 

support mechanism, forum or process otherwise indicated by Avaya.  Avaya monitors applicable mechanisms, forums, or 

processes but is under no obligation to implement any of Feedback, or be required to respond to any questions asked via 

the applicable mechanism, forum, or process. Licensee hereby assigns to Avaya all right, title, and interest in and to 

Feedback provided to Avaya.   

2.12(a) Fees and Taxes.  To the extent that fees are associated with the license of the SDK, Licensee agrees to pay to Avaya 

or pay directly to the applicable government or taxing authority, if requested by Avaya, all taxes and charges, including 

without limitation, penalties and interest, which may be imposed by any federal, state or local governmental or taxing 

authority arising hereunder excluding, however, all taxes computed upon Avaya’s net income. If You move any Software, 

including the SDK, and as a result of such move, a jurisdiction imposes a duty, tax, levy or fee (including withholding 

taxes, fees, customs or other duties for the import and export of any such Software), then You are solely liable for, and 

agree to pay, any such duty, taxes, levy or other fees. 

 

2.12(b) Audit.  Avaya shall have the right, at its cost and expense, to inspect and/or audit (i) by remote polling or other 

reasonable electronic means at any time and (ii) in person during normal business hours and with reasonable notice 

Licensee’s books, records, and accounts, to determine Licensee’s compliance with this Agreement.  In the event such 

inspection or audit uncovers non-compliance with this Agreement, then without prejudice to Avaya’s termination rights 
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hereunder, Licensee shall promptly pay Avaya any applicable license fees.  Licensee agrees to keep a current record of the 

location of the SDK. 

 

2.13 No Endorsement.  Neither the name Avaya, Affiliates nor the names of contributors may be used to endorse or 

promote products derived from the Avaya SDK without specific prior written permission from Avaya. 

2.14 High Risk Activities.  The Avaya SDK is not fault-tolerant, and is not designed, manufactured or intended for use or 

resale as on-line control equipment or in hazardous environments requiring failsafe performance, such as in the operation 

of nuclear facilities, aircraft navigation or aircraft communications systems, mass transit, air traffic control, medical or 

direct life support machines, dedicated emergency call handling systems or weapons systems, in which the failure of the 

Avaya SDK could lead directly to death, personal injury, or severe physical or environmental damage ("high risk 

activities"). If Licensee uses the Avaya SDK for high risk activities, Licensee does so at Licensee’s own risk and Licensee 

assumes all responsibility and liability for such use to the maximum extent such limitation or exclusion is permitted by 

applicable law. Licensee agrees that Avaya and its suppliers will not be liable for any claims or damages arising from or 

related to use of the Avaya SDK for high risk activities to the maximum extent such limitation or exclusion is permitted 

by law.  

2.15 No Virus.  Licensee warrants that (i) the applications, interfaces, value-added services and/or solutions, workflows or 

processes Licensee develops using this SDK will not contain any computer program file that includes time code limitations, 

disabling devices, or any other mechanism which will prevent the Avaya product (including other software, firmware, 

hardware), services and networks from being functional at all times (collectively “Time Bombs”); and (ii) the applications, 

interfaces, value-added services and/or solutions, workflows or processes Licensee develops using this SDK will be free 

of computer viruses, malicious or other harmful code, black boxes, malware, trapdoors, and other mechanisms which 

could: a) damage, destroy or adversely affect Avaya product, or services and/or end users;   b) allow remote/hidden attacks 

or access through unauthorized computerized command and control; c) spy (network sniffers, keyloggers), and d) damage 

or erase such applications, interfaces, value-added services and/or solutions, workflows or processes developed using this 

SDK or data, or any computer files or systems of Avaya, Affiliates, and/or end users (collectively “Virus”). In addition to 

any other remedies permitted in the Agreement, if Licensee breaches its warranties under this Section, Licensee will, at its 

expense, take remedial action to eliminate any Time Bombs and/or Viruses and prevent re-occurrence (including 

implementing appropriate processes to prevent further occurrences) as well as provide prompt, reasonable assistance to 

Avaya to materially reduce the effects of the Time Bomb and/or Virus. 

2.16 Disclaimer. Any software security feature is not a guaranty against malicious code, deleterious routines, and other 

techniques and tools employed by computer “hackers” and other third parties to create security exposures. Compromised 

passwords represent a major security risk. Avaya encourages You to create strong passwords using three different character 

types, change Your password regularly and refrain from using the same password regularly. You must treat such 

information as confidential. You agree to notify Avaya immediately upon becoming aware of any unauthorized use or 

breach of Your user name, password, account, API Key, or other credentials as provided by Avaya for use of the SDK, or 

subscription. You are responsible for ensuring that Your networks and systems are adequately secured against unauthorized 

intrusion or attack and regularly back up of Your data and files in accordance with good computing practices. 

2.17 Third Party Licensed Software 

 

A. “Commercial Third Party Licensed Software” is software developed by a business with the purpose of making 

money from the use of that licensed software.  “Freeware Licensed Software” is software which is made available 

for use, free of charge and for an unlimited time, but is not Open Source Licensed Software.  “Open Source 

Software" or "OSS" is as defined by the Open Source Initiative (“OSI”) https://opensource.org/osd and is software 

licensed under an OSI approved license as set forth at https://opensource.org/licenses/alphabetical (or such successor 

site as designated by OSI). These are collectively referred to herein as “Third Party Licensed Software”. 

 

B. Licensee represents and warrants that Licensee, including any employee, contractor, subcontractor, or consultant 

engaged by Licensee, is to the Licensee’s knowledge, in compliance and will continue to comply with all license 

obligations for Third Party Licensed Software used in the Licensee application created using the SDK including 
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providing to end users all information required by such licenses as may be necessary. LICENSEE REPRESENTS 

AND WARRANTS THAT, TO THE LICENSEE’S KNOWLEDGE, THE OPEN SOURCE LICENSED 

SOFTWARE EMBEDDED IN OR PROVIDED WITH LICENSEE APPLICATION OR SERVICES DOES NOT 

INCLUDE ANY OPEN SOURCE LICENSED SOFTWARE CONTAINING TERMS REQUIRING ANY 

INTELLECTUAL PROPERTY OWNED OR LICENSED BY AVAYA OR END USERS TO BE (A) 

DISCLOSED OR DISTRIBUTED IN SOURCE CODE OR OBJECT CODE FORM; (B) LICENSED FOR THE 

PURPOSE OF MAKING DERIVATIVE WORKS; OR (C) REDISTRIBUTABLE ON TERMS AND 

CONDITION NOT AGREED UPON BY AVAYA OR END USERS. 

 

C. Subject to any confidentiality obligations, trade secret or other rights or claims of Licensee suppliers, Licensee 

will respond to requests from Avaya or end users relating to Third Party Licensed Software associated with 

Licensee's use of Third Party Licensed Software. Licensee will cooperate in good faith by furnishing the relevant 

information to Avaya or end users and the requester within two (2) weeks from the time Avaya or end user provided 

the request to Licensee. 

 

3. OWNERSHIP.  

3.1 As between Avaya and Licensee, Avaya or its licensors or suppliers shall own and retain all Intellectual Property rights, 

in and to the SDK and any corrections, bug fixes, enhancements, updates, improvements, or modifications thereto and 

Licensee hereby irrevocably transfers, conveys and assigns to Avaya, its licensors and its suppliers all of its right, title, and 

interest therein. Avaya or its licensors or suppliers shall have the exclusive right to apply for or register any patents, mask 

work rights, copyrights, and such other proprietary protections with respect thereto. Licensee acknowledges that the license 

granted under this Agreement does not provide Licensee with title or ownership to the SDK, but only a right of limited use 

under the terms and conditions of this Agreement.  

3.2 Grant Back License to Avaya.  Licensee hereby grants to Avaya an irrevocable, perpetual, non-exclusive, sublicensable, 

royalty-free, fully paid up, worldwide license under any and all of Licensee's Intellectual Property rights related to any 

Permitted Modifications, to (i) use, make, sell, execute, adapt, translate, reproduce, display, perform, prepare derivative 

works based upon, distribute (internally and externally) and sublicense the Permitted Modifications and their derivative 

works, and (ii) sublicense others to do any, some, or all of the foregoing.  

  

4.0 SUPPORT.  

4.1 No Avaya Support. Avaya will not provide any support for the SDK provided under this Agreement or for any 

Derivative Works, including, without limitation, modifications to the Source Code or applications built by Licensee using 

the SDK. Avaya shall have no obligation to provide support for the use of the SDK, or Licensee's  application, services or 

solutions which may or may not include redistributable Client Libraries or Sample Application Code, to any third party to 

whom Licensee delivers such  applications, services or solutions. Avaya further will not provide fixes, patches or repairs 

for any defects that might exist in the SDK or the Sample Application Code provided under this Agreement. In the event 

that Licensee desires support services for the SDK, and, provided that Avaya offers such support services (in its sole 

discretion), Licensee will be required to enter into an Avaya DevConnect Program Agreement or other support agreement 

with Avaya.  

4.2 Licensee Obligations. Licensee acknowledges and agrees that it is solely responsible for developing and supporting 

any applications, interfaces, value-added services and/or solutions, workflows or processes developed under this 

Agreement, including but not limited to (i) developing, testing and deploying such applications, interfaces, value-added 

services and/or solutions, workflows or processes; (ii) configuring such applications, interfaces, value-added services 

and/or solutions, workflows or processes to interface and communicate properly with Avaya products; and (iii) updating 

and maintaining such applications, interfaces, value-added services and/or solutions, workflows or processes as necessary 

for continued use with the same or different versions of end user and/or third party licensor products, and Avaya products. 

5.0 CONFIDENTIALITY.  

5.1 Protection of Confidential Information.  Licensee acknowledges and agrees that the SDK and any other Avaya technical 

information obtained by it under this Agreement (collectively, “Confidential Information”) is confidential information of 

Avaya.  Licensee shall take all reasonable measures to maintain the confidentiality of the Confidential Information. 
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Licensee further agrees at all times to protect and preserve the SDK in strict confidence in perpetuity, and shall not use 

such Confidential Information other than as expressly authorized by Avaya under this Agreement, nor shall Licensee 

disclose any Confidential Information to third parties without Avaya's written consent. Licensee further agrees to 

immediately 1) cease all use of all Confidential Information (including copies thereof) in Licensee's possession, custody, 

or control; 2) stop reproducing or distributing the Confidential Information; and 3) destroy the Confidential Information 

in Licensee’s possession or under its control, including Confidential Information on its computers, disks, and other digital 

storage devices upon termination of this Agreement at any time and for any reason. Upon request, Licensee will certify in 

writing its compliance with this Section. The obligations of confidentiality shall not apply to information which (a) has 

entered the public domain except where such entry is the result of Licensee's breach of this Agreement; (b) prior to 

disclosure hereunder was already rightfully in Licensee's possession; (c) subsequent to disclosure hereunder is obtained by 

Licensee on a non-confidential basis from a third party who has the right to disclose such information to the Licensee; (d) 

is required to be disclosed pursuant to a court order, so long as Avaya is given adequate notice and the ability to challenge 

such required disclosure.  

5.2 Press Releases.  Any press release or publication regarding this Agreement is subject to prior written approval of 

Avaya.  

6.0 NO WARRANTY. 

The SDK and Documentation are provided “AS-IS” without any warranty whatsoever.  AVAYA SPECIFICALLY AND 

EXPRESSLY DISCLAIMS ANY WARRANTIES OR CONDITIONS, STATUTORY OR OTHERWISE, INCLUDING 

THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 

NONINFRINGEMENT AND SATISFACTORY QUALITY. AVAYA DOES NOT WARRANT THAT THE SDK AND 

DOCUMENTATION ARE SUITABLE FOR LICENSEE'S USE, THAT THE SDK OR DOCUMENTATION ARE 

WITHOUT DEFECT OR ERROR, THAT OPERATION WILL BE UNINTERRUPTED, OR THAT DEFECTS WILL 

BE CORRECTED. FURTHER, AVAYA MAKES NO WARRANTY REGARDING THE RESULTS OF THE USE OF 

THE SDK AND DOCUMENTATION.  NEITHER AVAYA NOR ITS SUPPLIERS MAKE ANY WARRANTY, 

EXPRESS OR IMPLIED, THAT THE SDK OR DOCUMENTATION IS SECURE, SECURITY THREATS AND 

VULNERABILITIES WILL BE DETECTED OR SOFTWARE WILL RENDER AN END USER’S OR LICENSEE’S 

NETWORK OR PARTICULAR NETWORK ELEMENTS SAFE FROM INTRUSIONS AND OTHER SECURITY 

BREACHES. 

7.0 CONSEQUENTIAL DAMAGES WAIVER. 

EXCEPT FOR PERSONAL INJURY CLAIMS, AVAYA SHALL NOT BE LIABLE FOR ANY INCIDENTAL, 

INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH, ARISING OUT OF OR 

RELATING TO THIS AGREEMENT OR USE OF THE SDK, OR FOR THE LOSS OR CORRUPTION OF DATA, 

INFORMATION OF ANY KIND, BUSINESS, PROFITS, OR OTHER COMMERCIAL LOSS, HOWEVER CAUSED, 

AND WHETHER OR NOT AVAYA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.  

8.0 LIMITATION OF LIABILITY. 

EXCEPT FOR PERSONAL INJURY CLAIMS, IN NO EVENT SHALL AVAYA'S TOTAL LIABILITY TO LICENSEE 

IN CONNECTION WITH, ARISING OUT OF OR RELATING TO THIS AGREEMENT EXCEED FIVE HUNDRED 

DOLLARS ($500). THE PARTIES AGREE THAT THE LIMITATIONS SPECIFIED IN THIS SECTION WILL APPLY 

EVEN IF ANY LIMITED REMEDY PROVIDED IN THIS AGREEMENT IS FOUND TO HAVE FAILED OF ITS 

ESSENTIAL PURPOSE.  

9.0 INDEMNIFICATION. 

Licensee shall defend, indemnify and hold harmless Avaya, Affiliates and their respective officers, directors, agents, 

suppliers, customers and employees “Indemnified Parties”) from and against all claims, demand, suit, actions or 

proceedings (“Claims”) and damages, losses, liabilities, costs, expenses, and fees (including fees of attorneys and other 

professionals) (“Damages”) based upon  an  allegation pertaining to wrongful use, misappropriation, or infringement of a 

third party’s Intellectual Property right arising from or relating to Licensee’s use of the SDK, alone or in combination with 

other software, such as operating systems and codecs, and the, direct or indirect, use, distribution or sale of any software, 
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Derivative Works or other products (including but not limited to applications, interfaces, and application programming 

interfaces) developed utilizing the SDK.  

Licensee shall defend, indemnify and hold harmless the Indemnified Parties from and against all Claims and Damages 

arising out of or related to: (i) personal injury (including death); (ii) damage to any person or tangible property caused, or 

alleged to be caused by Licensee or Licensee’s application created by using the SDK; (iii) the failure by Licensee or 

Licensee’s application created by using the SDK to comply with the terms of this Agreement or any applicable laws; (iv) 

the breach of any representation, or warranty made by Licensee herein; or (v) Licensee’s breach of any obligation under 

the Licensee EULA. 

10.0 TERM AND TERMINATION. 

10.1 This Agreement will continue through December 31st of the current calendar year. The Agreement will automatically 

renew for one (1) year terms, unless terminated as specified in Section 10.2 or 10.3 below.  

10.2 Either party shall have the right to terminate the Agreement, upon thirty (30) days written notice to the other party.  

10.3 Notwithstanding language to the contrary, Avaya may terminate this Agreement immediately, upon written notice to 

Licensee for breach of Section 2 (License Grant), Section 5 (Confidentiality) or Section 12 (Compliance with Laws). 

Avaya may also terminate this Agreement immediately by giving written notice if a Change In Control should occur or if 

Licensee becomes insolvent, or voluntary or involuntary proceedings by or against Licensee are instituted in bankruptcy 

or under any insolvency law, or a receiver or custodian is appointed for Licensee, or proceedings are instituted by or against 

Licensee for corporate reorganization or the dissolution of Licensee, which proceedings, if involuntary, have not been 

dismissed within thirty (30) days after the date of filing, or Licensee makes an assignment for the benefit of its creditors, 

or substantially all of the assets of Licensee are seized or attached and not released within sixty (60) days thereafter, or if 

Licensee has ceased or threatened to cease to do business in the regular course. 

10.4 Upon termination or earlier termination of this Agreement, Licensee will immediately cease a) all uses of the 

Confidential Information; b) Licensee agrees to destroy all adaptations or copies of the Confidential Information stored in 

any tangible medium including any document or work containing or derived (in whole or in part) from the Confidential 

Information, and certify its destruction to Avaya upon termination of this License.  Licensee will promptly cease use of, 

distribution and sales of Licensee products that embody any such Confidential Information, and destroy all Confidential 

Information belonging to Avaya as well as any materials that embody any such Confidential Information. All licenses 

granted will terminate. 

10.5 The rights and obligations of the parties contained in Sections 2.3, 2.6, 2.7, 2.10, 2.11, 2.12, 3, and 5 through 17 shall 

survive any expiration or termination of this Agreement. 

11.0 ASSIGNMENT. 

Avaya may assign all or any part of its rights and obligations hereunder.  Licensee may not assign this Agreement or any 

interest or rights granted hereunder to any third party without the prior written consent of Avaya.  The term "assign" 

includes, but is not limited to, any transaction in which there is a Change In Control or reorganization of Licensee pursuant 

to a merger, sale of assets or stock. This Agreement shall terminate immediately upon occurrence of any prohibited 

assignment. 

12.0 COMPLIANCE WITH LAWS AND IMPORT/EXPORT CONTROL. 

Licensee shall comply with all applicable laws and regulations, including without limitation those applicable to data 

privacy, intellectual property, trade secret, and fraud. Licensee is advised that the Technical Information is of U.S. 

origin and subject to the U.S. Export Administration Regulations (“EAR”) and may be subject to applicable local 

country import/export laws and regulations.  Diversion contrary to U.S. and/or applicable local country law and/or 

regulation is prohibited. Licensee agrees not to directly or indirectly export, re-export, import, download, or transmit 

the Technical Information to any country, end user or for any use that is contrary to applicable U.S. and/or local country 

regulation or statute (including but not limited to those countries embargoed by the U.S. government). Licensee 

represents that any governmental agency has not issued sanctions against Licensee or otherwise suspended, revoked or 

denied Licensee's import/export privileges. Licensee agrees not to use or transfer the Technical Information for any use 

relating to nuclear, chemical or biological weapons, or missile technology, unless authorized by the U.S. and/or any 

applicable local government by regulation or specific written license. Additionally, Licensee is advised that the 

Technical Information may contain encryption algorithm or source code that may not be exported to government or 
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military end users without a license issued by the U.S. Bureau of Industry and Security and any other country’s 

governmental agencies, where applicable. 

13.0 WAIVER. 

The failure to assert any rights under this Agreement, including, but not limited to, the right to terminate in the event of 

breach or default, will not be deemed to constitute a waiver of the right to enforce each and every provision of this 

Agreement in accordance with their terms.  

14.0 SEVERABILITY. 

If any provision of this Agreement is determined to be unenforceable or invalid, this Agreement will not be rendered 

unenforceable or invalid as a whole, and the provision will be changed and interpreted so as to best accomplish the 

objectives of the original provision within the limits of applicable law.  

15.0 GOVERNING LAW AND DISPUTE RESOLUTION. 

15.1 Governing Law. This Agreement and any dispute, claim or controversy arising out of or relating to this Agreement 

(“Dispute”), including without limitation the formation, interpretation, breach or termination of this Agreement, or any 

issue regarding whether a Dispute is subject to arbitration under this Agreement, will be governed by New York State 

laws, excluding conflict of law principles, and the United Nations Convention on Contracts for the International Sale of 

Goods. 

15.2 Dispute Resolution. Any Dispute will be resolved in accordance with the provisions of this Section 15. The disputing 

party shall give the other party written notice of the Dispute in accordance with the notice provision of this Agreement. 

The parties will attempt in good faith to resolve each controversy or claim within 30 days, or such other longer period as 

the parties may mutually agree, following the delivery of such notice, by negotiations between designated representatives 

of the parties who have dispute resolution authority. 

 

15.3 Arbitration of Non-US Disputes. If a Dispute that arose anywhere other than in the United States or is based upon an 

alleged breach committed anywhere other than in the United States cannot be settled under the procedures and within the 

timeframe set forth in Section 15.2, it will be conclusively determined upon request of either party by a final and binding 

arbitration proceeding to be held in accordance with the Rules of Arbitration of the International Chamber of Commerce 

by a single arbitrator appointed by the parties or (failing agreement) by an arbitrator appointed by the President of the 

International Chamber of Commerce (from time to time), except that if the aggregate claims, cross claims and 

counterclaims by any one party against the other party exceed One Million US Dollars at the time all claims, including 

cross claims and counterclaims are filed, the proceeding will be held in accordance with the Rules of Arbitration of the 

International Chamber of Commerce by a panel of three arbitrator(s) appointed in accordance with the Rules of Arbitration 

of the International Chamber of Commerce. The arbitration will be conducted in the English language, at a location agreed 

by the parties or (failing agreement) ordered by the arbitrator(s). The arbitrator(s) will have authority only to award 

compensatory damages within the scope of the limitations of Section 8 and will not award punitive or exemplary damages. 

The arbitrator(s) will not have the authority to limit, expand or otherwise modify the terms of this Agreement. The ruling 

by the arbitrator(s)) will be final and binding on the parties and may be entered in any court having jurisdiction over the 

parties or any of their assets. The parties will evenly split the cost of the arbitrator(s)’ fees, but Avaya and Customer will 

each bear its own attorneys' fees and other costs associated with the arbitration. The parties, their representatives, other 

participants and the arbitrator(s) will hold the existence, content and results of the arbitration in strict confidence to the 

fullest extent permitted by law. Any disclosure of the existence, content and results of the arbitration will be as limited and 

narrowed as required to comply with the applicable law. By way of illustration, if the applicable law mandates the 

disclosure of the monetary amount of an arbitration award only, the underlying opinion or rationale for that award may not 

be disclosed. 

 
15.4 Choice of Forum for US Disputes. If a Dispute by one party against the other that arose in the United States or is 

based upon an alleged breach committed in the United States cannot be settled under the procedures and within the 

timeframe set forth in Section 15.2, then either party may bring an action or proceeding solely in either the Supreme Court 

of the State of New York, New York County, or the United States District Court for the Southern District of New York. 

Except as otherwise stated in Section 15.3 each party consents to the exclusive jurisdiction of those courts, including their 

appellate courts, for the purpose of all actions and proceedings arising out of or relating to this Agreement. 



January 2024  Getting Started with the Avaya Breeze® platform SDK 11 

 
15.5 Injunctive Relief. Nothing in this Agreement will be construed to preclude either party from seeking provisional 

remedies, including, but not limited to, temporary restraining orders and preliminary injunctions from any court of 

competent jurisdiction in order to protect its rights, including its rights pending arbitration, at any time. The parties agree 

that the arbitration provision in Section 15.3 may be enforced by injunction or other equitable order, and no bond or security 

of any kind will be required with respect to any such injunction or order. 

 

15.6 Time Limit. Actions on Disputes between the parties must be brought in accordance with this Section within 2 years 

after the cause of action arises. 

 

16.0  AGREEMENT IN ENGLISH. 

The parties confirm that it is their wish that the Agreement, as well as all other documents relating hereto, including all 

notices, have been and shall be drawn up in the English language only.  Les parties aux présentes confirment leur volonté 

que cette convention, de même que tous les documents, y compris tout avis, qui s'y rattachent, soient rédigés en langue 

anglaise.    

17.0 ENTIRE AGREEMENT.  

This Agreement, its exhibits, schedules and other agreements or documents referenced herein, constitute the full and 

complete understanding and agreement between the parties and supersede all contemporaneous and prior understandings, 

agreements and representations relating to the subject matter hereof.  No modifications, alterations or amendments shall 

be effective unless in writing signed by both parties to this Agreement.  

18. REDISTRIBUTABLE CLIENT FILES. 

The list of SDK client files that can be redistributed, if any, are in the SDK in a file called Redistributable.txt. 
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Schedule 1 to Avaya SDK License Agreement 

Third Party Notices 

 

 

 

1. CODECS: WITH RESPECT TO ANY CODECS IN THE SDK, YOU ACKNOWLEDGE AND AGREE YOU 

ARE RESPONSIBLE FOR ANY AND ALL RELATED FEES AND/OR ROYALTIES, IF ANY.  IT IS YOUR 

RESPONSIBILITY TO CHECK.   

THE H.264 (AVC) CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 

PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION 

TO: (I) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEO") AND/OR (II) 

DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY 

AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO.  NO LICENSE 

IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.   ADDITIONAL INFORMATION FOR THE 

H.264 (AVC) CODEC MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.  

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.mpegla.com/
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Overview  
The goal of this guide is to get the Software Development Kit (SDK) installed so you can start 

developing snap-ins on Avaya Breeze® platform. When you are ready to learn how to install, 

configure and test an Avaya Breeze® platform snap-in, see Administering Avaya Breeze® 

platform. To develop snap-ins, you should have some knowledge of Java. After following this 

guide, you will be ready to learn how to develop your very own Avaya Breeze® platform snap-

ins using the SDK. We will walk you through the following steps: 

• Getting the Eclipse IDE installed and configured.  

• Getting Apache Maven installed and configured.  

• Obtaining and loading the Avaya Breeze® platform SDK into the IDE.  

• Importing and building the Hello service snap-in, also called the HelloWorld snap-in, to 

validate your Avaya Breeze® platform is installed and configured correctly.  

There is a video that goes along with this guide. Click here https://www.avaya.com/breezedeveloper 
for the video and other Avaya Breeze® platform resources. You must stay connected to the internet 
during the entire process of getting the SDK set up.  
 

Note: Breeze® platform underlying uses WebSphere version which didn’t supports java 8 so it is 
recommended not to use any java8 specific code during snap development as snap-in gets 
deployed under WebSphere runtime. 

  

Eclipse installation 
Instructions for installing the Eclipse IDE are at https://wiki.eclipse.org/Eclipse/Installation. The 

instructions there tell you to install a Java Environment. Since you will be developing, make sure 

to install the JDK. We recommend the OpenJDK, although any of the JDKs should work as long 

as they are version 1.8.x compliant. We recommend that you download and use the Eclipse 

4.28.0 (2023-06).  It already includes the Maven Plug-in. If you have an earlier version of 

Eclipse, you must upgrade to Eclipse 4.16.0 (2020-06) version or higher. Download the Package 

Solution named “Eclipse IDE for Java EE Developers”. Get the one that matches your 

development box, Windows or Linux, 32 bit or 64 bit. We recommend that you download and 

use the zip install.  

Eclipse 4.29.0 (2023-09) Support  
A Java 8 JRE or JDK (or higher) is required to run all Eclipse 2023-09 packages based on Eclipse 

4.29.0.  For use with the Avaya Breeze SDK, you must install and set the path and classpath for 

JDK 1.8. You can also explicitly specify the path in eclipse.ini using the javaw.exe command with 

the -vm argument. For example:  
-vm C:\Program Files\Java\jdk1.8.0_92\bin\javaw.exe 

 

https://www.avaya.com/breezedeveloper
https://www.avaya.com/breezedeveloper
https://wiki.eclipse.org/Eclipse/Installation
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Apache Maven installation  
Maven is an easy way to build the code you write into services that can be deployed. Visit the 

following link for Maven: http://maven.apache.org/users/index.html . It is a good site for 

becoming familiar with Maven if you have not used it. In about 10 minutes you can learn enough 

to get going with Maven. As with all freeware, newer versions are always being released. At the 

publication of this manual, Maven Version 3.9.5 is the most stable. It is the version we 

recommend and use in the instructions.  

Installing Apache Maven on a UNIX-based system 

About this task  
Follow this set of instructions if you are running UNIX. UNIX-based systems include Linux, Solaris 
and Mac OS X. To make sure environment variables persist, add them to bashrc or bash_profile 
if using the bash shell. If you are using other shells, you may need to add them to the profile.  

Procedure  
1. Extract the distribution archive, i.e. apache-maven-3.9.5–bin.tar.gz to the directory where 

you want to install Maven 3.9.5.  

These instructions assume you chose /usr/local/apache-maven. The subdirectory apache-

maven-3.9.5 will be created from the archive.  

2. In a command terminal, add the M2_HOME environment variable, e.g. 

exportM2_HOME=/usr/local/apache-maven/apache-maven-3.9.5.  

3. Add the M2 environment variable, e.g. export M2=$M2_HOME/bin.  

4. Optionally add the MAVEN_OPTS environment variable to specify JVM properties, e.g. 

export MAVEN_OPTS=”-Xms256m -Xmx512m”.  

This environment variable can be used to supply extra options to Maven.  

5. Add the M2 environment variable to your path, e.g. export PATH=$M2:$PATH.  

6. Make sure that JAVA_HOME is set to the location of your JDK, e.g. 

exportJAVA_HOME=/usr/java/jdk1.8.x and that $JAVA_HOME/bin is in your PATH 

environment variable.  

7. Run mvn –version to verify that it is correctly installed. 

 

 

Installing Apache Maven on a Windows system 

About this task  

Follow this set of instructions if you are running Windows.  

http://maven.apache.org/users/index.html
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Procedure  
1. Unzip the distribution archive, i.e. apache-maven-3.9.5–bin.zip to the directory where you 

want to install Maven 3.9.5.  

These instructions assume you chose C:\Program Files\Apache SoftwareFoundation. The 

subdirectory apache-maven-3.9.5 will be created from the archive.  

2. Add the M2_HOME environment variable by opening the system properties (WinKey 

+Pause), selecting the Advanced tab, and the Environment Variables button, then adding 

the M2_HOME variable in the user variables with the value C:\Program 

Files\ApacheSoftware Foundation\apache-maven-3.9.5. Be sure to omit any quotation marks 

around the path even if it contains spaces.  

Ensure that the M2_HOME does not have a “\” as the last character.  

3. In the same dialog, add the M2 environment variable in the user variables with the value 

%M2_HOME%\bin.  

4. Optionally in the same dialog, add the MAVEN_OPTS environment variable in the user 

variables to specify JVM properties; e.g., the value -Xms256m -Xmx512m.  

This environment variable can be used to supply extra options to Maven.  

5. In the same dialog, update/create the Path environment variable in the user variables and 

prepend the value %M2% to make Maven available in the command line.  

6. In the same dialog, make sure that JAVA_HOME exists in your user variables or in the 

system variables and it is set to the location of your JDK, e.g. C:\Program Files\Java\jdk1.8.x 

and that %JAVA_HOME%\bin is in your PATH environment variable. 

7. Open a new command prompt (Winkey + R then type cmd) and run mvn --version to verify 

that it is correctly installed. 

 

 

Installing the Avaya Breeze® platform SDK  
About this task  

After you install the correct version of Eclipse and Maven you are ready to install the Avaya 

Breeze® platform SDK. The SDK is packaged in one zip file. Perform the following steps for 

obtaining and installing the SDK.  

Procedure  
1. Click the Avaya Breeze® platform SDK link at the Avaya DevConnect website, 

http://www.avaya.com/ breezedeveloper.  

2. Read the End User License Agreement (EULA). The SDK zip will be downloaded if you 

accept.  

3. Unzip it to a directory or folder, for example, Avaya-Breeze-SDK. This directory will be 

referred to as SDK_HOME in this guide.  

http://www.avaya.com/breezedeveloper
http://www.avaya.com/breezedeveloper
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4. Find your way to SDK_HOME and for Linux or Mac OS, run bash install.sh or for Windows, 

run install.bat as Administrator.  

5. Accept the EULA agreement by entering y. The SDK components will be set up into your 

local repository. This may take a while to complete.  

6. During the install, you will be prompted to install the Eclipse Plug-in for Avaya Breeze® 

platform. If you want to install the plug-in:  

a. Enter y.  

b. Enter the complete path to the Eclipse install directory without quotes. For 

example, enter C:\Eclipse.  

The Eclipse Plug-in for Avaya Breeze® platform allows you to execute common Avaya 

Breeze® platform actions without executing commands on multiple systems. If you are a 

Windows user and you installed Eclipse using the .zip file, you will have to copy the eclipse 

plug-in jar manually to make it work. Copy file lib/com.avaya.zephyr.eclipse.plugin.jar from 

the SDK to the Eclipse dropins directory.  

Note:  

If the Eclipse installation directory is under Program Files, the command prompt on 

Windows 7 and later releases should be launched with Administrator rights to install 

the SDK and Eclipse plug-in.  

7. If Eclipse is running, restart it.  

Next steps  
If you did not elect to install the Eclipse Plug-in for Avaya Breeze® platform as part of the SDK 
install, you can install it separately at another time. If you elected to install the Eclipse Plug-in for 
Avaya Breeze® platform, you may configure it whenever Eclipse is running. 

Installing the Avaya Breeze® platform Eclipse plug-in  
About this task  

If you did not install the Avaya Breeze® platform Eclipse plug-in when you installed the Avaya 

Breeze® platform SDK, you have two choices. You can rerun the SDK installation or complete 

the steps in this procedure.  

Procedure  
1. Locate and cd to the folder where you unzipped the SDK.  

2. For Linux run the command eclipse.sh. For Windows, run the command eclipse.bat  

3. Enter y to install the Eclipse plug-in.  

4. If Eclipse is running, restart it.  

5. Verify that a new Avaya icon is now visible on the Eclipse Toolbar.  
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Next steps  
To configure the Avaya Breeze® platform Eclipse plug-in follow the instructions in the Avaya 
Breeze® platform Snap-in Developer's Guide. Now proceed to Importing the HelloWorld Snap-
in.  

Configuring Maven  
About this task  

Use the following procedure to configure Maven 3.9.5 to work with Java 1.8.  

Procedure  
1. In Eclipse, navigate to Window > Preference > Maven > Installations > Add > New 

Maven runtime and then select the Maven installation directory. 

2. Click Finish.  

3. From the Installations page, select Maven 3.9.5 and click OK.  

4. Navigate to Window > Preference > Java > Installed JREs and click Edit.  

5. In Edit Default VM arguments, type -Dmaven.multiModuleProjectDirectory=$M2_HOME.  

 

Importing the Hello service snap-in  
About this task  

We have written an Avaya Breeze® platform service project named the Hello service and 

included the source in the SDK. Let’s use it to verify that the SDK is installed correctly and that 

your development environment is ready to go.  

Procedure  
1. In Eclipse, click File > Import. Then under Maven, select Existing Maven Projects. 
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2. Click Next and browse to SDK_HOME/SDK-ZIP/samples/helloservice, where SDK_HOME is 

the place where you unzipped the SDK.  

3. Click Finish. 

This will take a while, errors may appear briefly, but once the import is finished no errors 

should be visible. Four related projects should now show up in your Eclipse Project 

Explorer Window. 
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Next steps  
Build the Hello service snap-in.  

 

Building the Hello service snap-in  
About this task  

Now that the projects are imported, let’s build and verify.  
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Procedure  
1. Right click on the top project, the one named simply helloservice, and go to Run as > 

Maven Install.  

This will take some time the first time, as it will have to download a lot of files into the local 

repository. It is OK if some warnings appear.  

2. When finished, hit the F5 key to refresh the view.  

This is always a good idea when using Eclipse.  

3. Expand the helloservice-svar /target directory.  

There should be a helloworld-<X.X.X.X.X>.svar file there. The X.X.X.X.X is a version number 

such as HelloWorld-2.0.0.0.0.svar.  

 
 

This .svar file is a type of zip file that contains all the parts of a working Avaya Breeze® 

platform service. It can be deployed on the Avaya Breeze® platform server and you can 

now build an Avaya Breeze® platform snap-in. The last step is to get rid of the helloservice 

so you can start afresh.  

4. Select all of the projects in the Project Explorer window and click Delete.  

5. Leave the box that says Delete content on disk unchecked and click OK. 

The Project Explorer Window should now be empty. 
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Next steps  
Congratulations, the SDK is installed correctly, and your development environment is proven 

ready. 

What’s next  
Now it’s time to have some fun and learn how to code up your very own snap-in. We have plenty 

of help for you. As a matter a fact we have a guide, Avaya Breeze® platform Snap-in 

Development Guide. When you are ready to verify your lab is set up correctly and understand 

how to install and configure the HelloWorld snap-in, use Quick Start to deploy the HelloWorld 

Snap-in. Simply click here to find both books, https://www.avaya.com/breezedeveloper .  

Note:  

The Hello service snap-in does not work with Zang-enabled Avaya Breeze® platform. Use 

the Call Deflect sample application to deploy and test a snap-in using Zang-enabled Avaya 

Breeze® platform.  

 

  

  

https://www.avaya.com/breezedeveloper
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